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            	With the release of AnzioWin version 16, we began supporting the emailing of PDF and TIF files created from AnzioWin's Print Wizard passthrough print process. The generated PDF file or TIF file may now be emailed with little effort, to a designated recipient.
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	 PDF and TIF File Generation


	AnzioWin allows for a passthrough print job to either print to a Windows Default printer, print to a user-selected printer, for a PDF to be generated or for a TIF file to be generated. Additionally, you can now email the PDF file or the TIF file to a recipient of your choice or have AnzioWin provide a user interactive dialog for emailing the PDF or TIF as an attachment.


	This setup is done through the AnzioWin Printer Setup dialog, found under the File menu:


	


	This dialog allows you to select how the next incoming print job from the host will be processed.


	One additional item that first needs to be discussed, is setting up an email default for AnzioWin to use.


	Email Setup


	This version of AnzioWin supports several different email types and delivery methods. From the Edit menu, select "Email setup":


	


	All of these protocols require different items to successfully connect to an email server or gateway, and your email server or email gateway may not allow access from all of these variations.


	Likewise, certain firewalls and routers, both on the local PC and on your network, may block some of these protocols.


	
		CDO

	
		Collaboration Data Objects are automation compatible object models that wrap MAPI for easier use. Whereas MAPI requires some configuration, CDO handles this for you and makes some assumption to simplify sending and receiving of email, faxes and calendar events. We have implemented the sending of email within the Print Wizard engine. CDO is currently not available on Windows Vista.

	
		MAPI

	
		The Messaging Application Programming Interface comes in various flavors with support for many 3 rd party applications such as Outlook (MAPI), Outlook Express (Simple MAPI), Exchange (Extended MAPI), and others. Print Wizard implements standard MAPI with support for sending of email and the handling of Outlook profiles. MAPI is available on most all Windows platforms in some form or another, but it does assume user profiles and some initial setup have been performed.

	
		Most often the default profile for MAPI will be "Outlook". Information non this profile and other profiles available, are found in the "Mail" settings in your Control Panel.

	
		OUTLOOK

	
		For those users with Outlook installed, Outlook provides object level interfaces direct to the program. Print Wizard has implemented the basic calls for sending email directly into Outlook, obeying any rules, permissions and profiles that Outlook has defined.

	
		Most often the default profile for MAPI will be "Outlook". Information non this profile and other profiles available, are found in the "Mail" settings in your Control Panel.

	
		SMTP

	
		The Simple Mail Transport Protocol is the standard Internet protocol for transporting email messages. The implementation of SMTP by Print Wizard assumes that your Windows machine has permissions to send email through your local email gateway (using the email gateway as a relay). This may not always be the case, but usually if any of the above methods work, this will.




	 



	So, How Do I Set Up AnzioWin to Print To A PDF?


	Within the Printer Setup dialog, you can choose "PDF" under the Print Wizard option. This will force the next job coming in to create a PDF file.


	There are many options that you can set pertaining to the PDF and what should happen:


	1) Optionally, you can add a file name, including a directory, where you want the print job's new PDF file to reside.


	If you do not provide one, the file name will be called Printwiz_Output.pdf and will be located in the AnzioWin directory. Additionally, any more files printed to that same directory, with no file name set, will be "unique", appending a file number to that name:


10/19/2007  01:03 PM           110,752 Printwiz_Output.PDF
    10/19/2007  01:29 PM             4,442 Printwiz_Output0001.PDF
    10/19/2007  01:30 PM             4,442 Printwiz_Output0002.PDF
    10/19/2007  03:33 PM         1,778,367 Printwiz_Output0003.PDF
    10/19/2007  03:35 PM               224 Printwiz_Output0004.PDF
    12/26/2007  03:02 PM             1,626 Printwiz_Output0005.PDF
    12/27/2007  01:57 PM             1,744 Printwiz_Output0006.PDF
    01/11/2008  09:10 AM             2,148 Printwiz_Output0007.PDF
    01/16/2008  09:42 AM             2,371 Printwiz_Output0008.PDF
    01/16/2008  10:12 AM             2,371 Printwiz_Output0009.PDF


	2) You can select to VIEW the file, using your default PDF viewer, usually Adobe Acrobat Reader on most PCs. When you select this box, AFTER the file is generated, the viewer will be brought up for that file.


	3) You can optionally enter authorship attributes for your new PDF file. Choose the Setup button, found on the Printer Setup screen after the PDF File Name field. This will allow you to select authorship attributes for your generated PDF file.


	


	From this screen you can also enter a file name, enter your name, title, subject and PDF security settings. You can also select to VIEW the PDF, to Email it, or select to force this dialog to appear for each and every PDF generated, which is handy if you want to selectively change this information for each passthrough print job.


	4) If you select Email, and your default email setting is anything other than Outlook, the form changes to allow you to enter permanent email information.


	


	In most cases, you will not want your email to be forwarded every time to the same person, so you can leave most of this blank for now. However, once a print job is received, and you have the box set to "Show this dialog every time...", this same dialog will appear.


	If your email type is Microsoft Outlook, we support the Outlook SendMail form and it will appear automatically whenever any passthrough print job is received.


	If you do not provide an email address in this setup dialog, the appropriate dialog will always appear anyway (i.e. this form for non-Outlook email transports, and the Outlook SendMail dialog for Outlook).


	Actually Printing and Emailing a PDF File


	This is started by simply performing your normal passthrough print function from your host application. Refer to the Printing with Anzio and A Guide To Anzio Passthrough Printing for more information.


	If you have the "Show this dialog every time..." checkbox checked on the PDF setup form, you will see it again here. Also if you have the "Email the PDF" checkbox checked on the same form, you will get the appropriate email sender dialog (the one above for non-Outlook settings and the one below for Outlook as your email type).


	


	 



	So, How Do I Set Up AnzioWin to Print To A TIF File?


	Within the Printer Setup dialog, you can choose "TIF" under the Print Wizard option. This will force the next job coming in to create a TIF image file.


	There are many options that you can set pertaining to the TIF and what should happen:


	1) Optionally, you can add a file name, including a directory, where you want the print job's new TIF image file to reside.


	If you do not provide one, the file name will be called Printwiz_Output.tif and will be located in the AnzioWin directory. Additionally, any more files printed to that same directory, with no file name set, will be "unique", appending a file number to that name:


10/19/2007  01:03 PM           110,752 Printwiz_Output.TIF
    10/19/2007  01:29 PM             4,442 Printwiz_Output0001.TIF
    10/19/2007  01:30 PM             4,442 Printwiz_Output0002.TIF
    10/19/2007  03:33 PM         1,778,367 Printwiz_Output0003.TIF
    10/19/2007  03:35 PM               224 Printwiz_Output0004.TIF


	2) You can select to VIEW the file, using your Windows default TIF viewer. When you select this box, AFTER the file is generated, the viewer will be brought up for that file.


	3) You can optionally select various file attributes for your new TIF file. Choose the Setup button, found on the Printer Setup screen after the TIF File Name field. This will allow you to select attributes for the image file you will be generating.


	By default the TIF format is set for a faxable TIF file. You can adjust these here - refer to the AnzioWin manual for options.


	


	From this screen you can also select to Email it, or select to force this dialog to appear for each and every TIF generated, which is handy if you want to selectively change this information for each passthrough print job.


	4) If you select Email, and your default email setting is anything other than Outlook, the form changes to allow you to enter permanent email information.


	


	In most cases, you will not want your email to be forwarded every time to the same person, so you can leave most of this blank for now. However, once a print job is received, and you have the box set to "Always show this dialog...", this same dialog will appear.


	If your email type is Microsoft Outlook, we support the Outlook SendMail form and it will appear automatically whenever any passthrough print job is received.


	If you do not provide an email address in this setup dialog, the appropriate dialog will always appear anyway (i.e. this form for non-Outlook email transports, and the Outlook SendMail dialog for Outlook).


	Actually Printing and Emailing a TIF File


	This is started by simply performing your normal passthrough print function from your host application. Refer to the Printing with Anzio and A Guide To Anzio Passthrough Printing for more information.


	If you have the "Always show this dialog..." checkbox checked on the TIF setup form, you will see it again here. Also if you have the "Email TIF" checkbox checked on the same form, you will get the appropriate email sender dialog (the one above for non-Outlook settings and the one below for Outlook as your email type).


	


	 



	AnzioWin Commands for PDF, TIF and Email


	The AnzioWin command structure allows you to set up many of the printing options and, specifically those pertaining to PDF and TIF generation, from either a host command or from a user-defined macro within AnzioWin.


	The commands are listed here for demonstration purposes only and are as of AnzioWin version 16.0c. As we fine tune emailing of passthrough print jobs, these commands may change. Please refer to the AnzioWin manual for exact syntax.


	
		emailsetup

	
		
			fromaddress=<>

			from=<>

			password=<>

			server=<>

			profile=<>

			user=<>

			port=<>

			auth=on

			auth=off

			type=CDO

			type=MAPI

			type=OUTLOK

			type=SMTP

	

	
		printer pdf://filename?options

	
		
			where "?options" can be one of the following:

		
			?title=<>

			?subject=<>

			?author=<>

			?keywords=<>

			?user=<>

			?owner=<>

			?permissions=<>

			?view

			?view=off

			?showdialog

			?email

			?email=

			?emailname=

			?emailfrom=

			?emailfromaddress=

			?emailattachments=

			?emailnotes=

			?emailsubject=

	

		
			Refer to the Print Wizard or AnzioWin user manuals for more information.

			 
	
			If an option of ?email is specified with no "TO" address, a dialog will be called up for the user to enter this information each time an email is to be sent.

			 
	
			If no "filename" option is provided, the default file name of "PrintWiz_Output.pdf will be used and dropped into the same directory as the executable. If that file exists, it will find the next available file name by appending a sequential number to the file name (before the extension).


	
		printer tif://filename?options

	
		
			where "?options" can be one of the following:

		
			?density=<>

			?format=color

			?format=gray

			?format=mono

			?width=<>

			?height=<>

			?view

			?view=off

			?compression=<>

			?email

			?email=

			?emailname=

			?emailfrom=

			?emailfromaddress=

			?emailattachments=

			?emailnotes=

			?emailsubject=

	

		
			Refer to the Print Wizard or AnzioWin user manuals for more information.

			 
	
			If an option of ?email is specified with no "TO" address, a dialog will be called up for the user to enter this information each time an email is to be sent.

			 
	
			If no "filename" option is provided, the default file name of "PrintWiz_Output.tif will be used and dropped into the same directory as the executable. If that file exists, it will find the next available file name by appending a sequential number to the file name (before the extension).






	Setting Up Email From the Host


	AnzioWin and its host command structure allows you to do the above setup commands from a host script. A typical host script might look like this:


	
		echo -e "\034emailsetup type=OUTLOOK \035"




	From a script or from a host application, you can send the AnzioWin commands wrapped inside the AnzioWin command codes (we us x034 and x035 here as an example). These commands do affect the default settings for email.


	 



	Controlling Printing From The Host


	Similar to setting up email the way you want from a host-end script or application, you can also control the printing.


	A host script might need to set up email to use OUTLOOK as the email type, then select an outbound printer type of PDF:// (our "superfile" designation for writing to a PDF file), then generate a PDF and email it, and finally reset the printer type back to the Windows printer default. A script to do this might look like the following:


	echo " "

	echo -e "\034emailsetup type=OUTLOOK \035"

	echo -e "\034printer pdf://?email=mypc@somewhere.com?emailsubject=subject line?emailnotes="Hi"

	./passpt testfile

	echo -e "\034printer WPRN \035"

	echo "Done."


	If the default email setup is already set to OUTLOOK, and you wish to enter all the email information manually, this script or print job may be as simple as:


	echo -e "\034printer pdf://?email

	./passpt testfile

	echo -e "\034printer WPRN \035"


	Likewise, you may want to generate a TIF file compatible with faxing for emailing, from a passthrough print job. To do this, it could be as simple as:


	echo " "

	echo -e "\034emailsetup type=OUTLOOK \035"

	echo -e "\034printer tif://?email=mypc@somewhere.com?emailsubject=subject line?emailnotes="Hi"

	./passpt testfile

	echo -e "\034printer WPRN \035"

	echo "Done."


	In this case, the default TIF settings in AnzioWin are usually for a fax compatible TIF file. You could also create a color TIF file by specifying a ?FORMAT=COLOR option.


	 



	Controlling Printing From a Macro


	From within AnzioWin, you can set up user-defined macros to accomplish all that was talked about in the prior section. However, AnzioWin makes it much easier.

	
		Under the Macro menu in AnzioWin, you can select "Record".

		 
	
		Walk through and do your necessary changes to Email Setup under the Edit menu.

		 
	
		Go to Printer Setup and select PDF.

		 
	
		Click on the PDF Setup button and fill in the PDF Setup dialog as you wish.

		 
	
		Go to the Edit menu and turn off Record and assign it to a user-defined key, such as F12.



	Whenever the F12 is pressed, you would run a macro that does the setup portion for you. When you next do a passthrough print job, you will end up with a PDF bering emailed. You may want to set up a second macro to reset the printer setup to just print.


	Likewise you can do all this from the Macro menu and the Edit Macro dialog. In here you can add additional items and check out the work flow.


	The best way to learn AnzioWin Macros is to turn on Record, walk through a few steps, assign it to a user-defined key and then go to the Macro menu and the Edit dialog for that macro. You can then fine tune and manipulate the macro as well as see how AnzioWin builds the various commands.
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